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  Introduction  

Introduction 
Welcome to the user guide for the DME client version 2.0.  

This guide is divided into three parts: 

1 An introduction to DME - about the company Excitor A/S, what the DME system 
does, and about various aspects of DME that are shared between DME clients on 
all platforms. 

2 A platform-specific guide to the DME client - for S60, UIQ, Windows Mobile, 
Java, or iPhone. 

3 A description of how you can get more help, a list of procedures, a glossary, and 
an index. This part also applies to all DME client platforms. 

Please see the "DME Deployment Guide" for a description of how to install the DME 
client. 

Note that DME on iPhone does not yet support all features mentioned in this guide. 
 

Copyright information 
Copyright © 2007-09 Excitor A/S. 
All rights reserved. 

Due to continued product development, this information may change without notice. 
The information and intellectual property contained herein is confidential between 
Excitor A/S and the client, and remains the exclusive property of Excitor A/S.  

If you find any problems in the documentation, please report them to us through our 
customer support services. Excitor A/S does not warrant that this document is error-
free. Furthermore, Excitor A/S does not warrant that the illustrations and screenshots 
used in this document reflect your version or the latest version of the program 
described. For the latest version of this product documentation, go to the DME website 
DME http://www.excitor.com. 

No part of this publication may be reproduced, stored in a retrieval system, or 
transmitted in any form or by any means, electronic, mechanical, photocopying, 
recording or otherwise without the prior written permission of Excitor A/S. 

DME, DME Sync, VoiceExtender, SmartEncrypt, and AdaptivePush are trademarks of 
Excitor A/S. 

Microsoft SQL Server, Microsoft Exchange, Windows, Windows Server 2003, and 
Active Directory are trademarks or registered trademarks of the Microsoft Corporation 
in the United States and other countries. 

Lotus Notes® and Domino® are trademarks or registered trademarks of IBM 
Corporation. 

Apple, Apple iPhone and iPod Touch are trademarks or registered trademarks of Apple 
Corporation. 

All other trademarks are property of their respective owners. 
 

 

http://www.excitor.com/
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Company information 

 
12, Spotorno Allé 
2630 Taastrup 
Denmark 

 
Phone: +45 70 21 68 00 
E-mail: mail@excitor.dk 
Website: DME http://www.excitor.com 
 

About DME 
DME (Dynamic Mobile Exchange) offers synchronization of push e-mail, PIM 
information (calendar, contacts, to-dos), and optionally files, to mobile devices. It fully 
integrates mobile device management with state-of-the-art security and efficient 
software deployment. DME is a mobile client/server solution that works with mobile 
phones, smartphones and PDAs using Symbian, Windows Mobile, Java or iPhone*) as 
operating system. DME is developed by Excitor A/S. 

The solution enables large and midsize enterprises to deliver business mobility 
services to employees and to effectively manage and control mobile devices without 
compromising security. DME is device, network and operator independent and offers 
unparalleled TCO, unprecedented data and device security, and a very intuitive 
interface for users and administrators. 

*) Please note that due to limitations on the iPhone platform, not all server features 
are supported on the DME client for iPhone. 
 

http://www.excitor.com/
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Features and benefits 
 Convenient for the user: Push e-mail, calendar, contacts and to dos 

With DME on your mobile phone, smartphone, or PDA, you get your most critical 
and often used office tools in your pocket wherever you are, whenever you need it. 
E-mails appear on your phone the moment they hit your office mailbox.  

 Quickly back in the game: Instant service recovery 
Should your phone get lost or stolen, a new DME client can be pushed to a new 
phone in a few minutes after you purchase a new DME supported phone or borrow 
one from someone else – no matter where it happens. 

 Fretless security: Mobile security policy enforcement 
E-mails are encrypted over the air and on the device itself using full AES 128-bit 
encryption. Shell protection of the entire phone, requiring password to access all 
features except picking up calls, gives you further security options. 

 Freedom and ease-of-use: Effective control of all devices 
Gain a complete overview of your devices – regardless of make, model, or 
platform. Information about the device model, versions and programs installed on 
the device is listed in the Web-based DME control center for easy administration. 
Features, settings and available applications and network connections are all 
controlled centrally and can only be changed by the users to the extent this has 
been made possible by centrally applied security policies. Dividing the devices into 
groups makes it easy to change settings/features for many devices at a time. 

 Ease-of-use comes in many flavors: Simple support and administration 
Push software and upgrades via SMS or WAP to the users, permit them to serve 
themselves, or automatically upgrade software when the users log on. For support 
purposes, retrieval of device configurations and connection set-up makes it 
possible for you to help users who cannot connect, and a log of user actions assists 
you in identifying the problems and solving them. Notification of changes to server 
status can be sent to the DME administrators to ensure they are alerted to problems 
quickly. 

 Cost containment: Control of ongoing mobile cost 
Data and voice logs allow you to monitor activity levels real-time, and identify 
“expensive” behavior which can be reduced. Heavily-used operators can be 
determined and connection preferences can be set as default. Build advanced 
reports to get a clear view of your organization’s mobile traffic.  

 Freedom of choice: Versatility 
Works on any available network (WLAN/Wi-Fi, GSM, GPRS, 3G/UMTS, 
EDGE...), and on most devices from leading manufacturers. Works on Lotus 
Domino and/or Microsoft Exchange collaboration systems. 

(Please note that due to limitations specific to the iPhone platform, some of the 
features mentioned above are not supported on DME for iPhone.) 
 

Typographical conventions 
Before you start using this guide, it is important to understand the terms and 
typographical conventions used in the documentation. 

For more information on specialized terms used in the documentation, see the Glossary 
at the end of this document. 
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The following kinds of formatting in the text identify special information. 

Formatting convention Type of Information 
Bold Items you must select, such as menu options, 

command buttons, or items in a list. 

Special Bold Words with special meaning, for instance names of 
LDAP user groups. 

Emphasis Use to emphasize the importance of a point or for 
variable expressions such as parameters. 

Key+Key Key combinations for which the user must press and 
hold down one key and then press another, for 
example, Ctrl+P or Alt+F4. 

 
Caution - performing the action described may lead 
to loss of data or involves other risk. 

 
 

Terminology 
The following is a list of terms used in this guide, and an explanation of the term. 

Term Explanation 
DME Often used for the DME Client. 

DME Server The DME Web Administration Interface. 

Mail system The server based collaboration system that your company 
runs, typically Lotus Domino (Notes) or Microsoft 
Exchange (Outlook). 

DME menu The DME menu is the main menu in the DME interface. 
On some devices, you have to select Options to access the 
menu, on some you select More. 

Select To choose an item or a menu option, whether by clicking, 
tapping, or choosing in a menu. 

The features or interface elements mentioned in this part of the user guide apply to all 
phone platforms, and may be illustrated by images from any of the supported 
platforms: Java, Symbian, UIQ, Windows Mobile, or iPhone. The following icons are 
used to signify platforms: 

Icon Platform 

 

Applies to the DME Client for the Java platform. 

 

Applies to the DME Client for the Symbian platform. 

 
Applies to the DME Client for the Symbian UIQ platform. 

 Applies to the DME Client for the Windows Mobile 
platform. 
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Applies to the DME Client for iPhone. 

In some cases, there is more than one route to selecting an option. For instance, on 
UIQ devices you can create an e-mail either by selecting More > Create > E-mail or 
by tapping New in the touch options bar, leaving the focus on E-mail, and tapping 
OK. The manual will usually only mention the regular menu route. 
 

Time zones 
With DME, you can always keep your office in your pocket - including your office 
calendar. One challenge with calendars is the fact that sometimes we operate with 
multiple time zones. If we travel to a different time zone, we need to make sure that 
entries in our calendar reflect the change in time zones. 

When you arrive at an airport in a foreign country and turn on your device, a message 
from the phone operator will often tell you that your time zone has changed, and offer 
to adjust the time zone on your device for you. You should allow this, or adjust it 
yourself (see also the section about Java devices below). 

Now, when you start DME, DME will detect that the time zone has changed on the 
device, and ask if you want to change the time zone in DME. You should also do this. 
See General settings on page 43for instructions how to change the time zone in DME. 

If you follow these simple rules: 

1 Let the device match the local time zone 

2 Let DME match the device time zone 

– then you should have no problem with duplicate or apparently missing calendar 
entries. 

 

On Java, special considerations apply in connection with Daylight 
Saving Time (DST). The following applies to users of Sony 
Ericsson devices running JP-8: 

1 Make sure that the date and time is set correctly on the phone. 
This is done by selecting Menu > Settings > Time & date > 
My time zone (note that Auto time zone must be Off). Here 
you must select the correct time zone and location. If your 
display does not list locations, select Options > Search region 
in > Your area. 

2 Start DME, and log in. 

3 Select Options > Settings > General, and set the time zone to 
match your phone settings. 
If you do not do this, and there is a discrepancy between the 
phone settings and your DME settings, DME will prompt you 
to change the DME settings when you log in. 

4 Select Options > Tools > Import > Calendar to do a full 
import of your calendar from the collaboration server. 
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Data security 
DME has a strong focus on security. All e-mails are securely stored on the device - 
even if the SIM card is changed or the battery runs out after you have logged in. All 
data remains encrypted at all times using strong encryption, and is only decrypted to 
memory when it is displayed on screen. 

All communication with the server is encrypted, and the server can be set up to require 
a client certificate. 

It is not possible to export any data from the device to be read elsewhere. 

All DME-related data on the device (e-mails, calendar items, to-dos, contacts, and 
synchronized files) are deleted in the following events: 
 If the SIM card is changed (optional). 
 If the user name or password is entered incorrectly a number of times (set up by 

the DME administrator). 
 If a new user logs in. 

In addition, if the device is lost or stolen, the data on the DME client can be cleared 
remotely by sending a command from the DME server (remote wipe). You should 
always contact your DME Administrator immediately if you lose your device. 
 

Changing mailbox passwords 
Depending on your company's security policy, you must change your network 
password at regular intervals. Usually your network password is the same as your 
mailbox password, but on Domino collaboration systems this is not necessarily so. The 
DME client depends on the mailbox password to gain access to synchronize your e-
mail to the device. 

Your mailbox password can be changed from your desktop computer or from your 
device. If your collaboration system is based on Active Directory, a message may pop 
up telling you well in advance that it is time to change your password. If you ignore 
the warning, your current password will eventually become invalid, and you will be 
unable to log on to the system. 

You can either change your password from a desktop computer on the network or from 
the client.  
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 If your mailbox password is changed from a desktop computer on the network, the 
new password has to be verified on the server the first time you log in to the DME 
client. When you log in, and DME recognizes you as a user and recognizes your 
password, but detects that the password has been changed on the server, the 
following message is shown: 

 

 
You are then asked to enter your old password. 

1. Select Yes to verify the new password on the server. 

2. Enter your old password. 

3. Select Log in. 
You can now use DME as usual. 

 You can change your mailbox password from the client.  
1. Log in to the client as usual. 

2. Open the DME menu, and select Tools - Change password. 

3. Enter your existing password in the Old password field. 

4. Enter a new password in the New password field, and retype it in the Confirm 
new password field. 

5. Select OK. 

 

 
DME sends the password change request to the server. If the server accepts the 
request, a message tells you that your password has been changed. If the server 
rejects the request, a message tells you why the command failed. If the command 
fails, it can be an issue with the server setup, and you should contact your DME 
Administrator. 
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Switching users 
Unless forbidden by the DME Administrator, you can hand over your device to 
another person, even if it contains all your DME data. All e-mails,  calendar items, to-
do items, contacts, and synchronized files will be erased when the new user logs in. 

 

 
The new user is taken through the same verification process as described in Logging in 
on page 17. 
 

Changing SIM cards 
If you change the SIM card in your device, the DME client will ask for the new phone 
number the first time you log in to the DME client. It is important that the phone 
number is correct, as many features depend on the DME server's ability to send 
commands by SMS to the device. 

 

 
1 Enter the phone number. 

2 Select OK. 

The device phone number can be changed in the general settings (see General settings 
on page 43). 

Depending on the setting Action on SIM card change in the security settings, your 
DME data will be wiped from the device when you change the SIM card, or your 
device will be locked, or you are allowed to log in as usual. 

 

On Java, this feature is only supported by the DME client 
under certain conditions. 

For more information, see Security settings on page 44 in the Java Client User Guide.  
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This feature does not apply to iPhone. 

 
 

Synchronization overview 
The basic idea of the DME client is to keep the e-mail, calendar system, contacts, and 
possibly files of your mobile device up-to-date with the corresponding items on the 
corporate network. To do this, the DME client is synchronized with the collaboration 
system or the file server. E-mails, calendar items, and contacts are synchronized with 
the corporate collaboration system, and files are synchronized with files on the DME 
server or in a network location specified on the DME server. Please note that file 
synchronization requires a special license - please consult your DME administrator for 
more information. 
 

What is synchronized 
In the synchronization (sync for short) process, DME checks the following: 

1 Have any items been created? An item could be an e-mail, a contact, a calendar 
item, a to do, or possibly a file. If an item has been created, it is copied to the 
system on which it does not yet exist (for example, if an e-mail was created and 
sent from the mobile device, the e-mail is copied to the Sent folder on the 
collaboration system).  
Furthermore, the e-mail, calendar and other items on the mobile device are 
synchronized with respect to the time span for which items should be shown 
according to the settings. This is called the synchronization window. For instance, 
the settings may specify that the e-mail application should show e-mails for the last 
7 days. The sync process will then clear e-mails older than 7 days from the Inbox 
and other boxes except Drafts (on the mobile device only). 

2 Have any items been deleted? If an item, for instance a meeting, has been deleted 
in the collaboration system, the deletion will be reflected on the mobile device. E-
mails deleted on the mobile device will only be deleted on the collaboration system 
if the setting Delete only locally is disabled. 

3 Have any items been edited? If you for instance edit a spreadsheet on the mobile 
device, the sync process will update the spreadsheet on the DME server (if file 
sync. is enabled). In the same way, if you edit a contact on the mobile device or on 
the collaboration system, the change will be synchronized. 

 

Conflicts 
In some cases, a conflict may arise. For instance, if a meeting has been moved to 
another time on both the collaboration system and the mobile device, DME will 
resolve the conflict by moving the meeting to the time indicated in the DME client, 
and a message will be sent with information about this fact. 
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Synchronization methods 
The DME client can be synchronized in four ways: 

1 Server-initiated sync (Push) 
Whenever someone sends you an e-mail, a meeting invitation, or similar, it is 
received by the collaboration system. The DME server will check for such updates 
in the collaboration system at regular intervals and send a notification by network 
push or as an SMS (a text message) to the mobile device on which your DME 
client is installed. The notification is picked up, read, and (in the case of SMS 
push) deleted by the DME client, and a sync is initiated to make the device reflect 
the change in the collaboration system. The DME client will optionally notify you 
with a sound whenever a new e-mail has arrived in this way. Push sync is enabled 
and scheduled by the DME administrator. Notifications can also be sent in case 
system settings are updated or a server command is issued. 
Note that notifications may be disabled on the server. 

2 Scheduled sync 
The client can be set up to synchronize at regular intervals. When synchronizing, 
all enabled resources are synchronized - that is, if the Sync. option for the resource 
in question (for instance To-do sync.) is enabled. The sync intervals are the same 
for all resources. 

3 Pull sync 
For e-mail and calendar items, you can set up a separate schedule for 
synchronization. This way you can for example set up scheduled sync intervals for 
contacts, to dos, and files, disable scheduled sync for e-mail and calendar, and 
enable pull sync for e-mail and calendar with a more frequent schedule. 

4 Manual sync 
Finally, it is possible to synchronize the client with the server manually by 
selecting a menu item in the client. You can synchronize the different item types 
individually, or you can choose to sync all at the same time. 

When the DME client is performing a synchronization operation, status messages 
about the current sync process are shown in the interface. While the synchronization is 
in progress, you can cancel it by selecting Synchronize > Cancel sync. from the DME 
menu. 
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Importing items 
The first time you log in to the DME client after installing it, you will be asked if you 
want to import e-mail from the server. When you accept to do this (recommended), 
your e-mails are imported from the DME server according to the default settings 
specified for the device on the server. 

At any point you can choose to import items. In the DME menu, choose Tools > 
Import to see a list of items that can be imported: 
 All items 
 E-mail 
 Calendar 
 Contacts 
 To-dos (not iPhone) 
 Files (not iPhone) 

The Import all function is a shortcut to importing all possible items according to your 
platform and client settings. 

Since e-mails cannot be changed, importing or synchronizing e-mails amounts to the 
same thing. However, if you should find duplicate e-mail entries in your mailbox, you 
can choose to import your e-mail from the server to realign the synchronization. 

Calendar entries, contacts, and to-dos are another matter. For these items, there is a 
risk that seemingly duplicate entries occur in your calendar or contacts if you 
synchronize, and you risk losing entries that have been entered on the device before 
you installed DME. There are at least three possibilities: 

1 The device is brand new: 
You can safely import all items, as you have never added contacts or 
appointments on this device. 

2 You used to keep the device synchronized with the collaboration system using 
software such as Nokia PC Suite, Sony Ericsson Sync Station, Microsoft 
ActiveSync, or similar: 
You can assume that your contacts, calendar items and so on are up-to-date on the 
collaboration server. Therefore you should initially perform an Import of these 
items. Doing this clears data on the device and imports data from the server, 
ensuring that no duplicates occur. 

3 The device has not previously been synchronized: 

1. Perform a synchronization of the device. This matches contacts on the device 
with your personal contacts on the server. DME checks for duplicates, but this 
check is not completely reliable - for instance, if different data field is used for 
a contact on the device (if "Home Phone" is completed for "John Doe" on the 
device but not on the server, a near-duplicate will be created). 

2. Clean up your personal address book and calendar on the collaboration system 
(using Outlook or Notes). This is an important step. 

3. When you are done, Import the contacts and calendar to the device. This will 
erase duplicates and bring in a fresh set of calendar items and contacts from the 
server. 
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4. You can now add device specific features to the contacts, such as photos, speed 
dial keys, etc. These settings will not be lost when you synchronize contacts 
with the server (but they will if you import). 

If in doubt, please consult your DME administrator before importing or synchronizing 
these items the first time.  
 

Preferred operators 
On the DME server, the administrator can define a number of preferred operators. 
First, one or more home operators is selected for your own country or area. Then, for 
each home operator, one or more operators can be selected for any country in the 
world. The selected operators should be those operators with whom the home operator 
has roaming agreements, and where the roaming prices are the best. 

If this system is in effect, your DME client will warn you about a change of network 
operators when you travel. For example: 

You are based in the United Kingdom. Your company has a special rates agreement 
with Vodafone in the UK and throughout Europe, so the DME administrator has 
selected Vodafone as your home operator and Vodafone as preferred operator in 
Germany. Now say you travel to Germany on business. Your phone is set up to 
automatically change to another roaming operator, so it automatically changes to T-
Mobile. However, your DME client will show a message saying that in this country, 
your preferred operator is Vodafone, and you are encouraged to switch.  

 On Windows devices, the phone can switch to the correct operator for you. 

Up to three different, possible operators will be shown if multiple operators are 
selected on the server. 
 



  Windows Mobile devices  

C H A P T E R  

Windows Mobile devices 
This section contains the specific guide for DME Client 2.0 for Windows Mobile 
devices.  

The guide pertains to both Pocket PC devices and Smartphones. The main difference 
between the two types of devices is that the Pocket PC uses a stylus for input, whereas 
the Smartphone relies on keyboard and button input. This guide assumes that you are 
using Pocket PC, but will note if there are important differences between the two types 
of devices with regard to the use of DME. 
 

About Windows Mobile devices 
DME supports a wide range of devices, including, but not limited to, the following 
mobile devices running Microsoft Windows Mobile 5 or 6: 

 

HTC S710 
WM 6 
Smartphone 

HTC TyTN WM 
5 Pocket PC 

 

i-mate SP5 
WM 5 
Smartphone 

 

i-mate JASJAM 
WM 5 Pocket 
PC 

 

Palm Treo 
700w WM 5 
Pocket PC 

 

Qtek 8300 
WM5 
Smartphone 

For more information, see the DME Support http://www.excitor.com website. 

 

http://www.excitor.com/
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The model used throughout this manual for illustration purposes is the Pocket PC Qtek 
S200, running Windows Mobile 5: 

 
 

Using the DME client 
The DME client will usually be set up to launch automatically when you start the 
device. DME contains a number of security features that depend on the client being 
started. Furthermore, the client contains a feature that makes it impossible to shut 
down the client without also shutting down the device. For more information, see Data 
security on page 8. 
 

Locating and starting the client 
The DME client will usually be set up to launch automatically when you start the 
device. DME contains a number of security features that depend on the client being 
started. Furthermore, the client contains a feature that makes it impossible to shut 
down the client without also shutting down the device. For more information, see Data 
security on page 8. 

 Starting DME 
1 Tap Start. 

2 Tap Programs. 

3 Open DME Secure E-mail. 

 
If the client is already running, you can switch to the client using the task manager or 
the Today screen (Pocket PC) or home screen (Smartphone). 

When the DME client is installed, it is automatically added to the Today screen, so that 
information about the time of last sync with the server and the number of unread e-
mails is displayed: 
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 (DME information emphasis added). 

On Smartphones, you must add DME to the Home screen plugin manually by selecting 
an option in the General settings on page 43. 

If DME is for some reason not shown in the Today screen on your Pocket PC, you can 
set it up by opening the Today application in the Settings program group. Tap the 
Items tab, and select the DME check box: 

 
Tap OK, and exit the Settings program group to see the Today screen with the DME 
item. 

 
 

Logging in 
When the DME client is launched, the following screen is shown: 

 
You must log in with the same user name and password that you would use for the 
collaboration system on your desktop PC. For Lotus Domino users, this is your 
"Internet password". Contact your IT department if you have problems with your user 
name or password. 
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If the DME client was already running, and you are logging in again after logging out 
(either manually or automatically after a period of inactivity), the screen shows the 
time of the last synchronization with the collaboration system and the number of new 
e-mails. 

The client remembers the user name from your last login, unless the DME 
administrator has disabled this feature for security reasons. 

If you have changed SIM cards since the last time you logged in, DME will prompt 
you for your phone number. If this is the case, enter your phone number, and press Yes 
to continue. It is recommended that you always include your international country 
code (for instance "+45" for Denmark). You can change the phone number later in the 
General settings (see General settings on page 43). The phone number is used by the 
DME server when sending commands by SMS to the phone. 
 

First-time login 
If you are logging in to the client for the first time, the login process is different. When 
you start the client, the login screen is shown, but without the indication of last 
connection and number of new e-mails. 

 

 Logging in to DME for the first time 
1 Enter your user name and password, and select Login. 

2 Since this is the first time you enter your user credentials, DME needs to make a 
connection to the server to verify that your user name and password match, and 
asks the question "Password is unknown. Do you wish to verify your login with the 
server?" 

 
Select Yes, if you are sure you entered your password correctly. 
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DME stores your password in multi-hashed, encrypted form (that is, very secure) 
on the client. Therefore, the next time you log in to the client, you do not need to 
make a server connection to verify your login. However, when you do make a 
connection (for instance when you synchronize e-mail), your login credentials will 
be verified again. 

3 DME asks you to confirm the server path. If the installation file was pushed to 
your device from the server, the server path is sent to the device along with the 
installation file, in a separate SMS. When DME launches, the server path is read 
from that SMS, but you must confirm it. If DME was installed in another way, for 
instance through cable transfer, you must enter the server path here. The server 
path has the form https://dme.yourcompany.com/nam_xml, where 
dme.yourcompany.com is the name of the server where DME is installed. You 
do not need to enter the /nam_xml part. 
This does not apply if DME was installed using the OMA DM protocol. See the 
Client deployment guide for more information. 

4 You are now asked if you want to trust the DME certificate. You must select Yes 
to continue. 

5 If the login process is successful (that is, DME can establish a connection to the 
DME server and log in using your user name and password), you are prompted 
whether you want to import your e-mail at this point. 

 
This is a good idea after your first login. See Initial sync wizard see "Importing 
items" on page 13 for more information. 

You are now ready to use the DME client. 
 

The client interface 
DME seeks to use the navigation features and the look and feel that is native to the 
device on which it runs. For this reason the DME client may look different on different 
platforms and devices, but the basic structure of the client is always the same. 

The DME client consists of an e-mail client, which is also the DME control center. 
From here you can access all options in the DME client. DME uses the calendar and to 
do applications that are native to the current device. 

If you wish to secure the DME client, select Lock. The DME client is now locked, 
showing the Login screen. You need to enter your password to unlock the DME client 
again. The DME client is also locked after a period of inactivity as specified in 
Security settings on page 44. 
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The illustration below shows the main DME interface. 

 
The first screen you see after logging in is the Inbox, which displays the e-mails and 
meeting invitations that have been synchronized to the client. Use the stylus and/or 
navigation keys to navigate through the user interface. 

Use the navigation button to scroll through any e-mails. The folder bar (top bar 
showing the name of the current folder) shows the total number of e-mails and the 
number of unread e-mails in the current folder. The e-mail icon of unread e-mails is a 
red envelope: , and they are listed in bold font. 

 
 

Working with folders 
The DME mailbox consists of at least the following folders: Inbox, Outbox, Drafts, 
Sent, and Unread. The first four of these folders function as the corresponding folders 
on the collaboration system (Notes or Outlook). The Unread folder is a smart folder 
which shows all unread messages in any folder in the DME client. When an e-mail in 
the Unread folder is read, it disappears from view - but naturally remains in the folder 
from which it originated. 

Apart from these standard folders, subfolders created on the collaboration system 
(Notes or Outlook) can be shown on the client. Subfolders from the collaboration 
system can be shown if the folder synchronization feature is enabled on the DME 
server and on the client (see Folders settings on page 47). If enabled, you have access 
to all the e-mail folders on your collaboration system. With settings similar to the e-
mail settings (see E-mail settings on page 45) you can specify how many e-mails you 
want to see in each folder (by age in days) and whether you want to synchronize e-
mails in folders at all. This is specified as a system-wide setting. In the following 
section you can see how to specify different settings for each folder, including whether 
you want to receive a notification when a new e-mail arrives in a folder. 
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Navigating the folder tree 

 
To move between folders, tap the folder icon at the top left of the current mailbox. 
When you do this, DME shows a folder tree with all folders in the system. You can 
then use the stylus or the keys to move to the desired folder. Click or tap to open the 
folder in mailbox view. If a folder contains subfolders, tap the plus icon to the left of 
the folder to expand the folder, or press the Right navigation key. 

If a folder is marked with a grey color (as the Work folder in the illustration), it means 
that it cannot be selected. On Domino systems, you can create folders and subfolders at 
the same time by naming a new folder like this: Work\Testing. When created in this 
way, the parent folder (Work) cannot itself contain e-mails (but Testing can). Therefore 
you cannot select the parent folder here, but you can navigate to the subfolder.  

You can also access the folder tree view by selecting View - Folders in the DME 
menu. Apart from folders, you can access the calendar, to dos (tasks), and your 
contacts from the View menu. 
 

Setting folder options 
In Folders settings on page 47, you can set defaults for the way e-mail folders should 
be synchronized between collaboration system and client. If you have many folders on 
the collaboration system, it is recommended that you set up very restrictive default 
settings for performance reasons, and loosen up on individual folders as described 
below. 

To set up folder options, open the folder view described above, browse to the folder 
you want to customize, and select Settings in the DME menu. The following screen is 
shown: 

 
 Use default values 

If this field is set to Yes, the current folder uses the general settings specified (see 
Folders settings on page 47). If Apply to subfolders is also selected, the default 
settings will be applied to all subfolders below the current folder as well, when you 
press Done. If you change the value in this field from No to Yes, the settings in the 
remaining fields in this screen will be reset to the default values when you press 
Done. 
If you want to apply other settings than the default settings to this folder, you must 
select No in this field. 
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 Sync. folder 
This option can only be changed if Use default values above is set to No. If this 
field is set to Enabled, e-mails in the current folder are synchronized with the 
collaboration system, using the synchronization window defined in the field Days 
back below. To avoid too high load on the DME server, you should only 
synchronize those e-mail folders that you really need on the device. You can for 
example consider to not synchronize folders containing graphics-intensive 
newsletters etc. Synchronized folders are shown with a synchronization icon inside 
the folder:  or . 

 Days back 
This option can only be changed if Use default values above is set to No. When e-
mails are synchronized, e-mails from the last number of days selected here will be 
synchronized and available in the current folder. 

 Include in mail scan 
This option can only be changed if Use default values above is set to No. If this 
field is set to Enabled, you will receive notification when a new e-mail arrives in 
the current folder. New e-mail can "arrive in" subfolders by means of rules, which 
are set up on the collaboration system to automatically distribute new e-mails in 
folders. 

 Apply to subfolders 
If this field is set to Yes, the settings made in other fields in this screen are 
propagated to folders below the current folder when you press Done. Use this 
function with caution, as the setting may affect many folders. Note that you can 
choose this option regardless of the value of the field Use default values above. 

Note that even if you do not synchronize e-mails in folders, you can still access e-mails 
in any folder by using the e-mail search functionality described in the section E-mails 
(on server) on page 34. 
 

E-mail 
The first screen you see after logging in is the Inbox, which displays the e-mails and 
meeting invitations that have been synchronized to the client. 

To toggle between the different mailbox folders (Inbox – Outbox – Drafts – Sent – 
Unread), tap the folder icon at the top left of the mailbox to browse through the 
available folders, or select Tools > View > Folders in the DME menu. See Navigating 
the folder tree on page 21. By going through the menu, you can also access the 
calendar, to dos, and your contacts. 

Use the up and down navigation buttons to scroll through any e-mails in each folder. 
Press the left and right navigation buttons to jump to the bottom and the top of the list, 
respectively. 

The folder bar shows the total number of e-mails and the number of unread e-mails in 
the current folder. The e-mail icon of unread e-mails is a red envelope: , and they are 
listed in bold font. See The client interface on page 19. 
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Reading e-mails 
To open an e-mail, select the e-mail in a folder, and press the navigation key (or tap 
the e-mail). 

Scroll through the e-mail by using the navigation keys or dragging the scroll bar. 

If you click the navigation key while scrolling through the e-mail body, the e-mail 
body will be shown in full screen. To leave full screen mode, press the OK soft key. 
Note that link detection (see below) is not available in full screen mode. 

You can open the next unread e-mail by choosing Show next unread e-mail from the 
DME menu in the open e-mail. 
 

Links 
When scrolling through e-mails, the DME client will search for different links such as 
e-mail addresses, phone numbers, and web links. Whenever a link is found, it is 
highlighted. A number of options for the link are shown when you select Advanced 
options in the DME menu. 

For e-mail addresses and phone numbers, you can select the following options. 
 Call: If the highlighted field is a phone number, the Call option will dial the 

number. If the field is an e-mail address, the Call option will look up contacts with 
the e-mail address in question and present the phone number(s) of the found 
contact, allowing you to make a call to the contact. Press OK to call the selected 
phone number. 

 Add to contacts: The highlighted text is copied to the clipboard, a new contact is 
created in your Local contacts, and the text is pasted to an appropriate field. If the 
number or e-mail address already exists, DME will ask if you want to update the 
existing contact. 

 Edit contact: DME tries to find the contact in your Local contacts with the 
highlighted phone number or e-mail address. If found, DME opens it, allowing you 
to edit the contact. 

 Send e-mail to contact: If the highlighted field is an e-mail address, this option 
will create a new e-mail for the address. If the field is a phone number, this option 
will look up contacts with the number in question and present the e-mail 
address(es) of the found contact, allowing you to create an e-mail for the selected 
address. 

When a web address is highlighted, you can select Open Web address in the menu to 
open the link in the built-in browser. 
 

Attachments 
When you receive an e-mail with an attachment, you will see an attachment icon  in 
the mailbox. 

Graphics that have been embedded into an e-mail may be shown as attachments on the 
client. This requires DME server version 2.0 and above and that you run Domino as 
your collaboration system. 
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 Opening an attachment 
1 Open the e-mail. 

2 Select Attachments in the DME menu. 
A list of the attachments to the e-mail is displayed. 

 
3 Select the attachment. 

4 Select Yes to download and open the attachment. 
DME connects to the server. 

5 Select Yes to allow the attachment to be decrypted to disk. 
The attachment file is stored in a temporary folder on the device disk, which is 
outside the secure DME area. It is deleted from the temporary folder again when 
you log out of DME. If DME cannot delete the attachment immediately when you 
log out, for instance if it is still open in the application, it will keep trying at 
regular intervals. 

To save transmission time and space on the device, attachments are not stored on the 
device unless you specifically choose to download them. In the attachment list, the  
icon shows if the attachment is only located on the mail system server. A phone-and-
clip icon  means that the attachment has been downloaded to the device. 

The device supports several types of attachments depending on the programs installed. 
By default, the device will recognize several types of image files such as .bmp and 
.jpeg, sound files such as .wav, and text files. Usually the device will also be able to 
open Microsoft Office and Adobe PDF files. Please refer to the user manual of the 
device for further information. If the file is not supported by the device, an error 
message will be displayed. 

Apart from opening the attachment, you can  
 Save the attachment on the device. 
 Send the attachment via Bluetooth or other medium supported by your device (see 

Sending an attachment on page 25). 
 Delete the attachment from the temporary folder on the device (see Removing 

attachments on page 25). 
 Download all listed attachments to the device. 

Note that the DME administrator may have disallowed the download of attachments 
for security reasons. 
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Sending an attachment 

When an attachment has been downloaded to the device, you can use the device to 
send the attachment to an external source. 

 Sending an attachment (not by e-mail) 
1 Open the e-mail that contains the attachment. 

2 Open the DME menu, and select Attachments. 

3 Select the attachment. 

4 If the attachment has not been downloaded to the device (indicated by an  icon), 
you must choose to open the attachment first. 

5 Open the DME menu, and select Send to (or Send). 

6 Select the method by which you want to send the attachment (see below). 
Sometimes only one option is available, for instance Bluetooth, and the device will 
start the detection or transfer immediately. 

Follow the instructions from the device manual on how use the specified send method. 

Send method Description 
Via multimedia Creates a multimedia message (MMS) with the selected 

attachment. 

Via e-mail Creates an e-mail with the selected attachment using the 
built-in, usually POP3-based, e-mail program. 

Via Bluetooth Sends the selected attachment via a Bluetooth connection to 
another device or computer. 

Via infrared Sends the selected attachment via an infrared connection to 
another device or computer. 

 
 

Removing attachments 

When you download attachments to the device, the attachments will take up space on 
the device. To free this space, you have the option to remove downloaded files from 
the device. The attachments will not be deleted on the mail system, only on the DME 
client. 

 Removing a single attachment 
1 Open the e-mail containing the attachment. 

2 Open the DME menu, and select Attachments. 

3 Highlight the attachment. 

4 Open the DME menu, and select Remove from phone/Delete. This option is only 
shown if the attachment has in fact been downloaded to the device. 

5 Press Yes to confirm. 

For e-mails opened from the Outbox, Sent, and Drafts folders, the process is slightly 
different: 
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1 Open the e-mail containing the attachment. 

2 Open the DME menu, and select Attachments - Delete. 

3 Press Yes to remove all attachments from the e-mail. 

 Removing all attachments from the device 
1 Go to the Inbox. 

2 Open the DME menu, and select Actions – Delete all attachments. 

3 Press Yes to confirm. 
 

Viewing e-mail details 
You can see a summary of information about the e-mail you are reading. 

 Viewing e-mail details 
1 Open an e-mail. 

2 Open the DME menu, and select E-mail details. 

An information box shows information about the current e-mail. 

The information consists of details about the sender, the date and time the e-mail was 
sent, and a list of recipients of the e-mail (individual recipients or a mail group). 
 

Other e-mail options 
Apart from the options concerning attachments and e-mail details mentioned above, 
you can open the DME menu for more options: 
 Quick reply / Reply / Reply to All 

Create a reply to the e-mail - see Replying to e-mails on page 29. 
 Move to folder 

If folder synchronization is enabled, you can use this option to open the folder 
selection view (see Navigating the folder tree on page 21). Pick a folder, and 
select OK to move the current e-mail to the folder in question. 

 Forward 
You can forward the e-mail - see Forwarding e-mails on page 29. 

 Delete 
Delete the current e-mail. You can do this by pressing the Delete button as well. 

 Advanced options 
In this menu, two options are shown (more, if a link is selected - see Links on page 
23): 

 Copy to 'Book meeting' 

If you select this option, the currently open e-mail is converted to a new 
meeting invitation. The e-mail subject is used as meeting subject, and the e-
mail body is used as meeting description. For more information, see Booking 
meetings on page 38. 

 Copy to task 
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If you select this option, the currently open e-mail is converted to a new task in 
the Windows Mobile Tasks application. The e-mail subject is used as task 
heading, and the e-mail body is used as task description. 

 Show next unread e-mail 
Close the current e-mail, and show the next (newer) e-mail that has not been read 
yet. 

 

Creating and sending e-mails 
 Creating and sending an e-mail 

1 From any folder, open the DME menu, and select Create – E-mail. 

2 Enter message details as described in E-mail details on page 27. 

3 In the DME menu, select Send. 

The e-mail is now saved in the Outbox. Depending on the E-mail settings on page 45, 
the e-mail is sent immediately or queued for the next scheduled or manual sync. When 
the e-mail has been sent, it is moved to the Sent folder. 
 

E-mail details 
The e-mail form works like a normal e-mail with fields for Send to, Carbon Copy (CC), 
Blind Carbon Copy (BCC), Subject, and Body. If you need to type multiple recipients in 
a field, you can separate the recipients using a comma (Lotus Notes style) or a 
semicolon (Outlook style). 

Tip: Some collaboration systems are able to resolve names of known users. This means 
that you only have to enter the short name as the e-mail recipient. For instance, you 
could just enter sad in the Send to field, and the collaboration system would resolve 
(expand) the name to Sabine.Adelhof@excitor.com automatically. Ask your DME 
administrator if this is possible in your setup. 

Tip: In the e-mail body, you can insert a new line by pressing the center or right scroll 
key (depending on device model). This is especially relevant for users of devices that 
do not have a full keyboard. 
 

Address book integration 

If the cursor is placed in the To, CC or BCC field, you can search for contacts by 
pressing the navigation key. You can now choose to search for recipients in the Local 
contacts or the Global Address Book. 
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Local contacts are contacts stored on your device. This usually corresponds to your 
Personal Address Book on the collaboration system. Use the scroll keys to select the 
contact(s) you wish to send the e-mail to. 

The Global Address Book is the shared address book on the collaboration system. If 
you select this option, you can search for a contact by Name, E-mail address, 
Department, Country, or Title. For more information about how to select recipients 
using the global address book, see the procedure in Global Address Book on page 32. 

When you have selected the desired recipients, select OK. The e-mail address of the 
contact(s) will be added to the field from which you started selecting recipients. 
 

Saving as draft 
If you want to continue editing an e-mail at a later time, you can save the e-mail as a 
draft. 

 Saving an e-mail as a draft 
1 Open the DME menu, and select Save as draft. 

or 

2 Close the e-mail, and select Save as draft when asked. 

The e-mail is saved to the Drafts folder, and you are returned to the mailbox. When 
you want to finish the e-mail, you can open it from the Drafts folder, edit it, and send it 
in the usual way. 
 

Selecting message options 
You can sign, encrypt and mark the message with high importance. 

 Setting message options 
1 Open the DME menu in the e-mail you are creating, and select Message options. 

2 Scroll up/down to select an option. 

3 Click the navigation key to enable or disable the selected option. 

4 Select OK to set the options and return to the e-mail, or select Cancel to cancel 
your selections and return to the e-mail. 

Please note the following about signed and encrypted e-mail:  
 When you send a signed e-mail, and the DME server cannot find your private key 

on the server, an e-mail with a notification of the error "The DME Server could not 
send the signed S/MIME e-mail") is sent to you by the DME server. Your e-mail 
will be sent to the recipient; however, it will not be signed. 

 When you send an encrypted e-mail, the DME server needs to know the public key 
of each of the recipients of the e-mail. If the public key of one of the recipients is 
unknown to the server, an e-mail with a notification of the error ("Cannot find 
certificate for recipient: xx") is sent to you by the DME server. The e-mail will not 
be sent to any of the recipients. 

Using signed and encrypted e-mail requires special setup. Please contact your DME 
administrator. 
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Replying to e-mails 
When replying to an e-mail, you have the possibility to reply to sender with or without 
history (that is, with the original e-mail appended to the bottom of the e-mail) and 
reply to all with or without history. 

There are two ways of replying to an e-mail. 

 Replying to an e-mail 
1 Open the e-mail you want to reply to. 

2 Open the DME menu, and select Reply or Reply to All. 

3 Select With history or Without history. 

 Replying to an e-mail using Quick reply 
1 Open the e-mail you want to reply to. 

2 Open the DME menu, and select Quick reply. 
The functionality of selecting Quick reply is defined in the e-mail settings (see E-
mail settings on page 45). Here you can specify if Quick reply should correspond 
to selecting To sender with history, To sender without history, To all with 
history, or To all without history. 

In both cases, a new e-mail is created for the original sender and possibly all original 
recipients. If the e-mail you are replying to was signed, encrypted, or marked with high 
priority, DME will copy these settings to the new e-mail. 

You can now add text and attachments to the e-mail and send it. See Sending 
attachments on page 30 for information about how to work with attachments in e-mail 
replies. 
 

Forwarding e-mails 
You can forward an e-mail with all content, including attachments. 

 Forwarding an e-mail 
1 From any folder, open the e-mail. 

2 Open the DME menu, and select Forward. 

3 If the original e-mail contained attachments: 

Press Yes to include attachments, or 

Press No to send the e-mail without attachments 

See Sending attachments on page 30 for information about how to work with 
attachments in forwarded e-mails. 

You can now add recipients, text and attachments, and select Send to send the e-mail. 

For information about how to enter recipients, see Address book integration on page 
27. 

If the e-mail you are forwarding was marked with high priority, DME will copy this 
setting to the new e-mail. 
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Sending attachments 
You can include attachments in e-mails in two different ways: by forwarding an e-mail 
that already contains attachments, or by adding attachments from the device to new e-
mails (either original e-mails, forwarded e-mails, or replies). Furthermore, you can add 
attachments to meeting invitations. 

 Sending attachments in original e-mails and replies 
1 Create an e-mail (see Creating and sending e-mails on page 27 or Replying to e-

mails on page 29). 

2 Select Attachments in the DME menu. 

3 Select Add attachment in the DME menu. 

4 Browse to the file you want to add, and select Select. 
Repeat items 3-4 to add more attachments. After adding an attachment, you can 
use the DME menu to send attachments locally (see Sending an attachment on 
page 25), remove the attachment from the e-mail again, or open the attachment. 

5 Press Back when you are done. 

  

 Sending attachments in forwarded e-mails 
1 Forward an e-mail (see Forwarding e-mails on page 29). 

2 You can add attachments in the same way as for original e-mails (see above). 
or 
If the original e-mail contained one or more attachments, and you chose to include 
the attachments in the forwarded e-mail, you can now manage the attachments. 

3 In the DME menu, select Attachments > Open to see the list of attachments that 
were included from the original e-mail. 

4 You can now select one or more attachments to remove them from the e-mail, 
open them, or you can add more attachments in the same way as for original e-
mails (see above). 

Attachments in forwarded e-mails need not be downloaded to the device before they 
are sent. DME will pull the attachments from the collaboration system when the mail 
is sent, saving transfer costs. 

 Adding attachments to meeting invitations 
1 Create a meeting invitation (see Booking meetings on page 38). 

2 Add attachments in the same way as for original e-mails (see above). 

Note that the DME administrator may have blocked for adding new attachments from 
the device to e-mails. Furthermore, restrictions to the size of attachments apply. The 
default maximum size is 16MB, but this limit may have been increased or reduced by 
the DME administrator. 
 

Folder actions 
In each mailbox folder, you can perform a number of actions on one or more items. 
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Selecting multiple items 
You can select several items in sequence in a folder or list by dragging the stylus 
across the items. Selected items are highlighted. 
 

Marking read/unread 
When you read an e-mail in the DME client, the e-mail will be marked as read - that is, 
the e-mail icon is grey  and not red . Furthermore, the e-mail will be marked as 
read in the collaboration system the next time you synchronize. You can mark an e-
mail as unread after reading it, for instance in order to remember reading it when you 
get back to the office, or you can mark unread e-mails as read.  

The actions described below can apply to a number of selected items. See Selecting 
multiple items on page 31 for information about how to select multiple items. 

 Marking one, selected, or all e-mails as read or unread 
1 Open the DME menu, and select Actions. 

2 Select Mark read to mark the e-mail(s) as read, or 
Select Mark unread to mark the e-mail(s) as unread. 

3 Select Selected to mark the selected e-mail(s), or 
Select All to mark all e-mails. 

 

Sorting items 
You can sort items in the Inbox and the other folders ascending or descending by date, 
name, or subject. 

 Sorting items 
1 Open the DME menu, and select Actions 

2 Select Sort 

3 Choose between the following sort methods: 
Descending by date (newest e-mail at the top) 
Ascending by date (oldest e-mail at the top) 
Descending by name (by sender's name, Z-A) 
Ascending by name (by sender's name, A-Z) 
Descending by subject (by e-mail subject, Z-A) 
Ascending by subject (by e-mail subject, A-Z) 

The selected sort order applies to all folders. 

The currently selected sort order is disabled in the Sort menu, indicating which sort 
method is used. 
 

Deleting items 
When deleting an e-mail, the e-mail data is removed from the DME client. Depending 
on a setting in E-mail settings on page 45, the e-mail can also be deleted on the mail 
system at the next sync. 

The actions described below can apply to a number of selected items. See Selecting 
multiple items on page 31 for information about how to select multiple items. 



32 
 

DME Client User Guide : ©2009 Excitor A/S 
 

 Deleting one or more selected items 
1 Select the item or items to be deleted. 

2 Open the DME menu, and select Actions > Delete, or 
Press the Clear key. 

3 Press Yes to confirm the deletion. 

Note that if you delete a large number of items (more than 20 e-mails/meeting 
invitations or more than 10 contacts) at a time, the next time the device synchronizes, a 
message will ask you if you really want to delete the items on the server. This is to 
prevent the accidental deletion of many items. 

 Deleting the currently open e-mail 
1 Open the DME menu in the e-mail you are reading, and select Delete, or 

Press the Clear key. 

2 Press Yes to confirm the deletion. 
 

Moving items to other folders 
If folder synchronization is enabled, you can move e-mails between folders. The items 
are moved in the collaboration system as well at the next synchronization. 

The action described below can apply to a number of selected items. See Selecting 
multiple items on page 31 for information about how to select multiple items. 

 Moving an item to another folder 
1 Open the DME menu, and select Actions > Move to folder. 

2 The folder selection view is shown (see Navigating the folder tree on page 21).  

3 Browse to a folder, and click the navigation key to move the selected e-mail(s) to 
the folder in question. 

You cannot move e-mails to the Drafts, Sent, Outbox, or Unread folders. 
 

Search 
Using the DME client you can search for contacts in the global address book on the 
collaboration system, search e-mails in your mailbox on the collaboration system, or 
search e-mails already downloaded to the device. 
 

Global Address Book 
The Global Address Book is the shared address book on the collaboration system as set 
up by the network administrators. 

To create an e-mail message or a meeting invitation, you can open the DME menu and 
select Create as described in Creating and sending e-mails on page 27 or Booking 
meetings on page 38. However, you can also find the recipient or recipients of your e-
mail or meeting invitation first, and then choose to create a new e-mail or meeting 
invitation with the selected contacts as recipients (not all platforms yet). 
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 Finding contacts in the global address book 
1 Open the DME menu, and select Search > Global Address Book (this step has 

already been completed if you open the global address book from a new e-mail or 
meeting invitation). 
You can now search for a contact by Name, E-mail address, Department, Country, or 
Title. 
Note that more fields or different fields may be available if the Global Address 
Book search screen has been customized. See separate documentation about 
customizing the fields in this screen. 

2 Enter a search text in at least one of the available fields, and select Search.  
A connection is made to the collaboration system, and the search results are 
displayed. Depending on a setting on the DME server, the search will either look 
for entries starting with the text you have entered, or entries containing the text 
you have entered. When searching for a name, you can enter both a first and last 
name separated with a space. 
By default a maximum of 10 results are shown, but this value can be changed by 
the DME administrator.  

3 From the search results, you can select contacts the same way as with your local 
contacts. Selected contacts are marked with a . 

4 If you opened the global address book search from an e-mail or meeting invitation, 
select Done from the DME menu to insert the selected contacts into the field from 
which you chose to search for contacts. 
or 
If you opened the global address book search from the Search menu, select Create 
> E-mail or Create > Meeting from the DME menu to insert the selected contacts 
as recipients in a new e-mail or meeting invitation, respectively. 

Apart from the Done or Create options, the DME menu contains the following 
options: 
 New search: Return to the search screen with every option in the search screen 

reset to default values. (Note that this does not apply to the Windows Mobile 
client). 

 Select/Unselect: Select or unselect the currently highlighted contact. 
 Details: View more details about the selected contact. The type of details that can 

be seen depends on choices made by the administrator of the collaboration system. 
Select OK to close the details window. 

 Call: Any phone numbers associated with the highlighted contact are listed. Select 
one, and press OK to place a voice call with the contact, or Cancel to exit the 
menu. 

 Add to contacts: The details of the highlighted contact are copied to a new entry 
in your local contacts. You can edit the details and press Done to save the contact 
as a local contact. 
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E-mails (on server) 
The DME client only synchronizes e-mails from the last number of days specified in 
the e-mail settings (see E-mail settings on page 45). This is called the e-mail 
synchronization window. Sometimes you may need to find an e-mail which is stored in 
a folder in your collaboration system mailbox which is not synchronized to the DME 
client, or which is too old to be synchronized to the client. 

Using this function, you can search for any e-mail stored in any folder of your mailbox 
on the collaboration system. 

 Searching for e-mails on the server 
1 Open the DME menu, and select Search - E-mails (on server) 

2 Complete the search fields in the form: 

1. Search text: In this field enter the text to search for. 

2. Field: Select the e-mail fields in which to search for the specified text. Click to 
choose between the following options: 

Any field: All text fields are searched for the specified text string. 

Subject: Only the Subject field is searched. 

Subject, Body: Both the Subject and the Body fields are searched. 

3. Person: In this field enter all or part of the name of the sender of the e-mail 
you are looking for (or recipient in case you are searching your Sent folder). 

4. Folder: Choose the folder in which the e-mails to be searched are located. 
Click to choose between the mail folders defined in the mailbox on the 
collaboration system. 

Select a folder, and choose Done. For information about folders and folder 
selection, please see Selecting folders on page 36 below. 

5. If you want to search in all subfolders to the selected folder, select the check 
box Search in subfolders. This can only be selected if your collaboration 
system is Microsoft Exchange. 

6. Date: If you select this check box, DME enables two fields in which you can 
enter a range of dates. This limits the search to e-mails received within the 
selected time frame. The time frame is by default today's date. You cannot 
choose a date in the future. 

7. Results/page: In this field you can specify the number of results you wish to 
display per page. If your search generates a large number of results, it can take 
a considerable time to download all the results. Therefore you can define how 
many results you want to see at a time, and then browse to the next page of 
results. 

3 Select Search. 
Note that a search can only be executed if one or more of the fields Search text, 
Person, Folder, or Date has been completed. If not completed, an error message 
says "Search fields cannot be blank" when you select Search. 
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The search results are displayed. Note that the client shows the results in the order in 
which they are presented by the collaboration system. If your collaboration system is 
based on Lotus Domino, the search results are returned in order of relevance. If your 
collaboration system is based on Microsoft Exchange, the search results are returned in 
chronological order (that is, by date). 

The server sets a limit to the number of search results. By default, the limit is 100 
results. The results are divided into a number of pages, depending on the number of 
results per page you have selected. If more results are returned than the specified 
number of results per page, DME shows the first page. To see the next page, press the 
scroll key to the right, or click the right selection key (or choose Next page in the 
menu). You are then prompted if you want to download the next pageful of results.  

Note that the results are cached on the device for as long as you are performing the 
search. This means that browsing between result pages is instantaneous once the 
results have been downloaded. 

If no results are found, DME shows a message that no matches are found, and you are 
returned to the search screen after confirming the message. 

DME initially only retrieves the header information from the e-mails, that is sender, 
date, and subject. If you click to open an e-mail, DME asks you if you wish to retrieve 
the rest of the e-mail. If you select Yes, the e-mail in question is downloaded from the 
collaboration system and stored on the device. 

On the search results page, the DME menu has the following options: 
 New search: Return to the search screen with every option in the search screen 

reset to default values. 
 Refine search: Return to the search screen, but retain the selections you already 

made. 
 Previous page: If more results were returned than the specified number of results 

per page, and you are not looking at the first page, you can go to the previous 
pageful of results. Alternatively, press the scroll key to the left or click the left 
selection key. 

 Next page: If more results were returned than the specified number of results per 
page, you can go to the next pageful of results. Alternatively, press the scroll key 
to the right or click the right selection key. 

Press Close (or Back on some devices) to close the search and return to the e-mail 
folder from which you opened the search window. 

Please note that for best performance, your mailbox should be indexed. For more 
information about indexing your mailbox, see the documentation for Lotus Notes or 
Microsoft Outlook. 

Note also that if you choose to search in a folder which contains other folders, you will 
get different results depending on your collaboration system:  
 If you use Domino, the search for e-mails will be performed in the selected folder 

only. 
 If you use Exchange, a message will be shown: "Do you wish to include 

subfolders in your search?" If you answer Yes, e-mails in the subfolders of the 
selected folder will be searched as well. 
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Selecting folders 
When you select the folder list button, you can see a list of the e-mail folders in your 
collaboration system mailbox. The list is in the form of a tree structure, where you can 
expand and collapse the tree and individual branches by tapping the plus and minus 
icons. If Folder synchronization is enabled (see Folders settings on page 47), you see 
all folders in your collaboration system mailbox. Otherwise, the first time you display 
this list, you can only choose among All folders, Inbox, Drafts, and Sent. However, you 
can display the actual mail folders in your mailbox on the collaboration system by 
opening the DME menu and selecting Update folders. 

 

The DME client communicates with the server and downloads a list of the mail folders 
you have defined in your mailbox on the collaboration system. See Navigating the 
folder tree on page 21 for information about moving between folders. 
 

E-mails (on phone) 
From any mail folder, you can search for a text string contained in an e-mail in the 
DME client. 

 Searching for a text string 
1 Open the menu, and select Search - E-mails (on phone) 

2 Complete the search fields in the form: 

1. Search text: In this field enter the text to search for. This field cannot be blank. 

2. Field: Select the e-mail fields in which to search for the specified text. In this 
drop-down list you can choose between the following options: 

Any field: All text fields are searched for the specified text string. 

Sender: Only the Sender field (Recipient field in sent e-mails) is searched. 

Subject: Only the Subject field is searched. 

Body: Both the Subject and the Body fields are searched. 

3. Folder: Choose the folder in which the e-mails to be searched are located. 
Click the drop-down list to view the folder tree and choose among the mail 
folders synchronized to the device. If you do not select a folder, all folders are 
searched. 
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3 Select Search. 

The search results are displayed. The results are listed in a special Search mailbox 
similar to the Inbox.  

 
The DME menu has the following options: 
 New search: Return to the search screen with every option in the search screen 

reset to default values. 
 Refine search: Return to the search screen, but retain the selections you already 

made. 
 Previous page: If more results were returned than the specified number of results 

per page, and you are not looking at the first page, you can go to the previous 
pageful of results. Alternatively, tap the left arrow in the folder bar. 

 Next page: If more results were returned than the specified number of results per 
page, you can go to the next pageful of results. Alternatively, tap the right arrow in 
the folder bar. 

Press Close to close the search and return to the e-mail folder from which you opened 
the search window. 

 
 

Calendar 
DME uses the calendar application which is native to your device. You can create and 
edit personal appointments in the calendar application. When you synchronize 
calendar items, they will be entered into your collaboration system.  

However, whenever you want to invite other people to your meetings and 
appointments, you must use the DME client to create meetings. Also, meeting 
invitations from other people are received in the DME Inbox before being transferred 
to the calendar application (if accepted). 
 

Receiving meeting invitations 
When meetings are booked on the collaboration system, all invited participants receive 
a meeting invitation by e-mail, containing information about the meeting. 

In the DME client, a meeting invitation is recognized by a clock/e-mail icon  in the 
Inbox. 
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 Responding to a meeting invitation 
1 Open the meeting invitation. Browse through the pages of the invitation to see the 

subject and time of the meeting, who organized the meeting, who have been 
invited (participants), and any information about location and resources involved 
in the meeting. 

2 In the DME menu, you can now choose among the following options: 

 Accept: Accept the meeting invitation. The meeting is created in the calendar, 
and a notification of your acceptance is sent to the meeting organizer/chair. 

 Decline: Decline the meeting invitation. Notification of this is sent to the 
organizer/chair and any other participants. 

 Show calendar: Open your calendar application, for instance to check your 
other schedule for the day of the meeting. 

 Delete: Delete the meeting invitation without accepting or declining it. 

3 When you Accept or Decline a meeting invitation, you can add a comment about 
the invitation. If you enter a comment, it is sent to the organizer/chair. Select 
Continue and Yes to accept or decline the invitation. 

When you respond to a meeting invitation, the e-mail containing the invitation is 
removed from your Inbox, and if you accepted the meeting, your calendar is updated at 
the next calendar synchronization. 
 

Changing meeting details 
If you attempt to change details in a meeting where you are not the organizer/chair, 
DME will reject the change. For instance, if you change the time of a meeting which 
you did not originally organize, and then synchronize, the DME Server will send you 
an e-mail explaining that you could not change the time of a meeting which you did 
not book, and the meeting time will be reset. 
 

Booking meetings 
From the DME client you can book a meeting in you calendar. You can invite people 
to attend the meeting, and you can reserve rooms and resources. This basically works 
the same way as booking meetings in your collaboration system. 

 Creating a new meeting 
1 Open the DME menu, and select Create - Meeting. 

2 Enter meeting details: see Entering meeting details on page 39. 

3 Add participants: see Adding participants on page 39. 

4 Enter a location and book resources: see Location and resources. 

5 Add attachments: see Sending attachments on page 30. 

6 Select the Send soft key. 

The next time the DME client is synchronized with the DME server, meeting 
invitations will be sent to the selected participants, and the meeting will be created in 
you calendar. 
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A meeting invitation can also be created by converting an e-mail to a meeting 
invitation. See Advanced options see "Other e-mail options" on page 26. 

To navigate between the tabs Meeting details, Participants and Location and 
resources, highlight the tab, and then click the right or left navigation key to display 
the next or previous tab. 
 

Entering meeting details 
 

The Meeting details tab contains the following fields: 

 Subject: Enter a subject for the meeting.  
  Date and time: Enter starting and ending dates and times for the meeting. 

 Time zone: Enter the time zone for the starting and ending times. See Working 
across time zones see "Time zones" on page 7. 

 

 Alarm: Enable or disable the alarm. When the alarm is enabled, you can enter a 
date and time for when the alarm should go off. 

 

  Private: Mark the meeting as private. This means the the meeting details are 
not visible to other people in the collaboration system when you sync the calendar 
item, but your time will appear booked. 

 Description: Enter a description of the meeting, agenda, etc. 
 

Adding participants 
In the Participants tab, you can add meeting participants from Local contacts on the 
device and from the global address book on the server.  

 Entering meeting participants 
1 Tap the underlined Participants. 

or 
Open the DME menu. 

2 Select Local contacts 
or 
Select Global Address Book. 

For more information, see Address book integration on page 27. 
 

Location and resources 
In the Location and resources tab, you can enter a location for the meeting and book 
rooms and resources that are available in the collaboration system. 

In the form, you can enter information into the following fields: 
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 Location: Here you can enter free text describing the location of the meeting - for 
instance a country or city. 

 Rooms: Here you can book one or more of the rooms made available by the 
collaboration system. The rooms are listed in the drop-down list. See below. 

 Resources: Here you can book one or more of the resources made available by the 
collaboration system. The resources are listed in the drop-down list. See below. 

Before selecting rooms or resources, you must download the available rooms and 
resources from the collaboration system to your device. 

 Downloading rooms and resources 
In the Rooms or Resources field, open the DME menu and select Get resources and 
select Yes to download resources from the collaboration server. Alternatively, tap the 
underlined Rooms or Resources link above the field and select Yes. 

 Selecting rooms 
1 Tap the underlined Rooms link 

or 
Move the cursor to the Rooms field, and select Rooms in the DME menu. 

2 Scroll up and down, and mark the rooms you want to add. 

3 Select OK. 

 Selecting resources 
1 Tap the underlined Resources link 

or 
Move the cursor to the Resources field, and select Resources in the DME menu. 

2 Scroll up and down, and mark the resources you want to add. 

3 Select OK. 
 

Checking free time 
When participants, rooms and resources have been added, you can check if they are 
available within the specified time frame. This can be done from any of the tabs. 
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 Checking free time 
1 Open the DME menu, and select Check free time. 

After DME has checked on the server, you will see a message indicating whether 
all participants and resources are available or unavailable within the selected time 
frame. 

 
2 Select Yes to show alternative time frames 

or 
Select No to keep the current time frame. 
If you select Yes to show alternatives, you will see a list of time frames within 
which all participants and resources are available. 

 
3 Scroll up or down to select a new time frame. 

4 Select OK to use the selected time frame. 

The meeting details are changed to reflect the update. 
 

Contacts 
The Contacts application is populated by DME and reflects your personal address book 
on the collaboration system. Changes in either address book are synchronized to the 
other, if the setting Contacts sync. is enabled (see Contacts sync. settings). 

Whenever you create an e-mail or book a meeting (not iPhone), you can choose 
recipients from the Global Address Book or from your local contacts. See Address 
book integration on page 27 for more information. 



42 
 

DME Client User Guide : ©2009 Excitor A/S 
 

 See Importing items on page 13 for information about special considerations in 
connection with the initial synchronization or import of contacts from the collaboration 
system. 
 

To dos 
A to-do item is a special type of calendar item and is synchronized with your 
collaboration system by DME. When synchronized to the device, you can view and 
maintain the to-dos in the Tasks application. 

To-do items are created as tasks in the Windows Mobile Tasks application. They are 
synchronized with your collaboration system by DME. See Sync vs. import for 
information about special considerations in connection with initial synchronization or 
import of to dos from the collaboration system. 

For a to-do to be included in the synchronization from the collaboration system to the 
device, the following criteria must be fulfilled by the to-do on the collaboration 
system: 

1 A due date has not been specified, and it has not been marked as complete 
(Domino only). 

2 Or the to-do is overdue and not marked as complete, regardless of the values in the 
starting date and due date fields. 

3 Regardless of the above, a to-do is included if either the starting date or the due 
date is within the time span set in To-do settings on page 48 (the sync window). 

Examples: 

The sync window is set to 10 days in To-do settings, and today is April 15th.  

1 A to-do on the collaboration system was created on March 23rd with a due date on 
April 17th. This to-do is synchronized to the device because the due date is within 
the 10-day sync window specified in the To-do settings. 

2 Another to-do was created on March 3rd, with a due date of March 16th. It has not 
been marked as completed. This to-do is synchronized to the device. When it is 
marked as completed, it will no longer appear on the device. 

 

Limitations on to-do synchronization 
Please note that there is an upper limit to the amount of text that can be included in the 
subject and description fields of a to-do. This limit depends on the device platform and 
type. 

It is recommended to keep to-dos that are to be synchronized below this limit, as you 
will otherwise experience that text is cut off from the to-do when it is synchronized 
back to the collaboration system. 
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Settings 
When a new device is created in DME, a set of default settings for the device is sent to 
the client the first time the device connects with the server, or when a new user takes 
over an existing device. These settings should represent your company's security 
policy.  

Note that the DME administrator may have blocked your access to changing any or all 
of the settings described in the following sections. When a "permitted range" is 
mentioned in the following sections, the range may in fact have been changed by the 
DME administrator. 

The "Installation Best Practise" guide contains information for DME administrators 
about recommended settings and permitted range values. 
 

General settings 
 Launch on startup 

Select Yes/Enabled to make the DME client launch every time you start your 
device. This is default and highly recommended for security purposes. 
Select No/Disabled if you want to start the DME client manually. 

 Language 
In this field you can specify which language to use for the DME interface. The 
language is not necessarily the same as the language selected on the device. 

 Phone number 
The phone number of the device. The DME server needs to know your phone 
number for sending SMS messages and pushing downloads etc. to the device. 

 Disconnect after synchronization 
If you select this option, DME sill shut down the GPRS connection after 
synchronizing. This is the default value, and is recommended to save connection 
costs. 
If you do not select this option, the GPRS connection is never shut down. 

 Server path 
This is the path to the DME server. The value is set automatically when installing 
the DME client. The server path should rarely be changed, and only if your DME 
Administrator tells you to. 

 Time zone 
In this field you can specify the time zone you are currently in from a list of time 
zones. Phone default is default, meaning that the time zone is set according to the 
phone. For more information about time zones and DME, see Working across time 
zones see "Time zones" on page 7. 
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 Network push 
If this function is enabled, the device is set up to receive network (IP) push. This 
means that notifications are received over the GPRS network instead of by SMS. 
The result is faster and usually cheaper notification. This requires that the DME 
server is set up correctly. If the GPRS network is for some reason unavailable, the 
DME server will detect this and send notifications by SMS instead. This system of 
falling back to SMS is called AdaptivePush™. Whenever network push is enabled 
and working on your device, a flash icon  is displayed next to the DME logo at 
the top of your DME client. 
Note that this feature may be disabled if you are roaming. For more information, 
see Roaming. 

 Network push path 

If network (IP) push is enabled, you must supply a path to the server providing 
the network push connection. This path is usually pushed to your device by the 
DME server. Please contact your DME administrator for more information. 

 IM awareness 

If your company uses the IBM Sametime instant messaging (IM) application, 
you can select this field to see the Sametime status of your Sametime contacts 
(buddy list). If you do this, a symbol next to the name of the sender of an e-
mail in a mailbox indicates his or her Sametime status: Away , In a meeting , 
Do not disturb , or Available . Please note that in order to use this feature, 
Network push must be enabled as well (see above). 

 

Security settings 
 Action on SIM change 

In this field you can choose how the DME client should react when a new SIM 
card is inserted into the device. You may need more than one SIM card, for 
instance if you travel and use local prepaid SIM cards. However, simply allowing 
SIM card changes poses a security threat, as a malevolent user might steal a device 
and insert his own SIM card in order to (potentially) gain access to files and other 
data on the device. Therefore you can choose among three options in this field: 

 None 

If you select this option, the DME client will do nothing when a user changes 
SIM cards. This is usually not recommended for the above stated reasons. 

 Flush data 

If you select this option, the DME client will flush (delete all DME data from) 
the device if another SIM card is inserted. For more information, see Data 
security on page 8. 

 Lock device 
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When the DME client detects the SIM card change, the client automatically 
switches to Lock device mode (Shell protection). You now have to log in to 
DME in order to use the device. You have as many chances to enter the correct 
password as the option Limit on password attempts specifies. Just before 
logging in, DME checks if the current SIM card has been used before. If it has 
not, the user is prompted to enter the phone number for the new SIM card. This 
phone number and the SIM card identification number (IMSI) are stored and 
thus recognized the next time the same SIM card is inserted. A maximum of 62 
pairs of phone numbers and SIM card IDs can be stored in this way. 

 Logout timeout (min) 
The DME client is locked automatically after the specified number of minutes of 
inactivity. Permitted range: 0-60 minutes. 

 Private key password 
If you have uploaded your personal certificate to the DME server (using myDME), 
you must enter the password for your private key in this field. For more 
information about S/MIME and myDME, contact your DME administrator. 

 Lock device 
If you select Enabled, the device is completely locked when you log out of the 
DME client. You are only able to receive voice calls, make emergency calls, 
receive (but not view) text messages, and respond to calendar alarm messages. For 
maximum security, enable the setting “Launch on startup” in the General Settings 
on page 43. This way, this level of security is maintained even if the device is 
rebooted. Furthermore, the DME client will automatically restart if it should crash. 
If you select Disabled, the device is not locked when you log out of the DME 
client. 

 Lock Calendar 
If you select Enabled, you can only access the calendar on the device when you 
are logged in to the DME client. See Lock Messaging above. 
If you select Disabled, the calendar is never locked. 

 Lock Contacts 
If you select Enabled, you can only access the Contacts application on the device 
when you are logged in to the DME client. See Lock Messaging above. 
If you select Disabled, the Contacts application is never locked. 

 Lock To-do 
If you select Enabled, you can only access the To-do application on the device 
when you are logged in to the DME client. See Lock Messaging above. 

 If you select Disabled, the To-do application is never locked. 
 

E-mail settings 
 E-mail sync. 

If you select Enabled/On, e-mail synchronization is enabled. This setting affects 
push mail, e-mail pull, manual synchronization, and scheduled sync. 
If you select Disabled/Off, e-mails are never synchronized. 

 Days back 
When e-mails are synchronized, e-mails from the last number of days selected here 
will be synchronized and available in the Inbox. Permitted range: 0-99 days. 
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 Send immediately 
If you select Yes/On, e-mails created on the device are sent immediately when you 
select Send from new e-mail. 
If you select No/Off, e-mails are stored in the Outbox folder when you select Send, 
and are not sent until the next scheduled or manual synchronization. 

 Delete only locally 
If you select Yes/On, e-mails deleted from the DME client will only be deleted on 
the device, and not on the collaboration system. This is the default. 
If you select No/Off, e-mails deleted on the client will be removed from both the 
DME client and the mail system at the next scheduled or manual synchronization. 

 Quick reply 
In this field you can specify the function of the option Quick reply in an open e-
mail. You can choose among the following options: 

1. To sender with history 

2. To sender without history 

3. To all with history 

4. To all without history 
When you select Quick reply in an open e-mail, DME will perform the function 
specified in this field. 

 Sound on 
If you select this check box, the device will play the sound selected in the field 
Mail alert when you receive an e-mail in DME. 

 Alerts start 

In this field you can specify the time of day from which you want to begin 
receiving audible alerts when a new e-mail arrives. Use the local time format, 
for instance hh:mm:ss or hh:mm:ss am/pm. Example: 08:00 or 08:00 am. 

 Alerts end 

In this field you can specify the time of day from which you no longer want to 
receive audible alerts when a new e-mail arrives. Use the local time format, for 
instance hh:mm:ss or hh:mm:ss am/pm. Example: 18:00 or 06:00 am. 

 Mail alert 

In this field you can specify the sound you want played when a new mail is 
received by DME. 

 E-mail pull 
If you select Enabled, client-initiated (pull) synchronization of e-mail is enabled. 
This corresponds to the Scheduled sync., but is independent of the synchronization 
schedule set up on the DME server. 
Select Disabled to disable the client-initiated sync. of e-mail. 
Note that this feature may be disabled if you are roaming. For more information, 
see Roaming. 

 Pull interval 

If E-mail pull is enabled, the client will initiate a sync. every number of 
minutes selected here. Permitted range: 10-120 minutes. 

 Start time 
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In this field you can specify the time of day after which client-initiated pull 
should start, if this is enabled. Use the local time format, for instance hh:mm:ss 
or hh:mm:ss am/pm. Example: 08:00 or 08:00 am. 

 End time 

In this field you can specify the time of day at which client-initiated pull 
should end, if this is enabled. Use the local time format, for instance hh:mm:ss 
or hh:mm:ss am/pm. Example: 17:30 or 05:30 pm. 

 Run on weekends 

If you select Yes, client-initiated pull will continue to run over the weekend. 

If you select No, client-initiated pull will not run on weekends. 
 Signature 

Any text you enter in this field will be appended to all new e-mails sent from the 
DME client. You typically use it for adding a signature. Note that the DME 
administrator can add another text to be appended to e-mails, called an "E-mail 
disclaimer". DME will add the signature from this field first, and then the e-mail 
disclaimer will be added by the DME server at the very end of the e-mail (after any 
reply history). 

 
 

Folders settings 
 Folders 

If you select Enabled, e-mail folder synchronization is enabled. This setting 
affects push notification, manual synchronization, and scheduled synchronization 
of e-mail folders. 
If you select Disabled, e-mail folders are never synchronized. 

 Days back 
In this field you can specify how many days back the DME client should 
synchronize e-mails in subfolders. Note that with higher numbers, the load on the 
DME server will increase. This number may be changed for individual folders. 

 Sync. folders 
In this field you can specify synchronization of e-mails in subfolders is enabled. 
This requires that the synchronization of Folders is enabled also. If Folders is 
enabled, the entire folder structure is synchronized between the collaboration 
system and the device. This setting determines if e-mails in the folders should be 
included in the synchronization for the number of days specified in the Days back 
field. If you do not select this field, e-mails in subfolders are never synchronized. 
However, you can change this setting on a per-folder basis - see Setting folder 
options on page 21. 

 

Calendar settings 
 Calendar sync. 

If you select Enabled, calendar synchronization is enabled. This setting affects 
push notification, calendar pull, manual synchronization, and scheduled sync. 
If you select Disabled, calendar items are never synchronized. 
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 Days back 
When items are synchronized, items from the last number of days selected here 
will be synchronized and available in the device Calendar. 

 Days forward 
When items are synchronized, items up until the number of days selected here will 
be synchronized and available in the device Calendar. 

 Calendar pull 
If you select Enable, client-initiated (pull) synchronization of calendar items is 
enabled. This corresponds to the Scheduled sync., but is independent of the 
synchronization schedule set up on the DME server. 
Select Disable to disable the client-initiated sync. of calendar items. 
Note that this feature may be disabled if you are roaming. For more information, 
see Roaming. 

 Pull interval 

If Calendar pull is enabled, the client will initiate a sync. every number of 
minutes selected here. 

 Start time 

In this field you can specify the time of day after which client-initiated pull 
should start, if this is enabled. Use the local time format, for instance hh:mm:ss 
or hh:mm:ss am/pm. Example: 08:00 or 08:00 am. 

 End time 

In this field you can specify the time of day at which client-initiated pull 
should end, if this is enabled. Use the local time format, for instance hh:mm:ss 
or hh:mm:ss am/pm. Example: 17:30 or 05:30 pm. 

 Run on weekends 

If you select Yes, client-initiated pull will continue to run over the weekend. 

If you select No, client-initiated pull will not run on weekends. 

 
 

Contacts settings 
 Contacts sync. 

If you select Enabled, contact synchronization is enabled. Your list of contacts on 
the device is synchronized with your personal address book on the collaboration 
system when a sync. is run. This setting affects all forms of synchronization. 
If you select Disabled, contacts are never synchronized. 

 
 

To-do settings 
 To-do sync. 

If you select Enabled, to-do item synchronization is enabled. This setting affects 
push notification, manual synchronization, and scheduled sync. 
If you select Disabled, to-dos are never synchronized. 
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 Days back 
When items are synchronized, items from the last number of days selected here 
will be synchronized and available in the device Calendar. 

 Days forward 
When items are synchronized, items up until the number of days selected here will 
be synchronized and available in the device Calendar. 

  
 

Files settings 
With these settings, you enable or disable the synchronization of files. File 
synchronization requires a special license and is set up on the DME server. For more 
information, please ask your DME administrator. 
 File sync. 

If you select Enabled, file synchronization is enabled. This setting affects push 
notification, manual synchronization, and scheduled sync. 
If you select Disabled, files are never synchronized. 

 

Scheduled sync. settings 
 Scheduled sync. 

If you select Enabled, the DME client will initiate synchronization of the enabled 
resources (e-mail, calendar, etc.) according to the schedule specified below. 
If you select Disabled, the synchronization of resources relies on client-initiated 
sync (pull, where applicable), manual synchronization, or push notification from 
the mail system. 

 Interval 
If Scheduled sync. is enabled, the client will accept a sync. every number of hours 
selected here. Permitted range: 1-24 hours. 

 Start time 
In this field you can specify the time of day after which scheduled sync. should 
start, if this is enabled. Use the local time format, for instance hh:mm:ss or 
hh:mm:ss am/pm. Example: 08:00 or 08:00 am. 

 End time 
In this field you can specify the time of day at which scheduled sync. should end, if 
this is enabled. Use the local time format, for instance hh:mm:ss or hh:mm:ss 
am/pm. Example: 17:30 or 05:30 pm. 

 Run on weekends 
If you select Yes, scheduled sync. will continue to run over the weekend. 
If you select No, scheduled sync. will not run on weekends. 
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Menu tree 
If you have access to the full DME client, the menu structure of the DME client is as 
follows. Note that the DME menu structure is dynamic. If your license does not 
include all functionality, or if some functionality is turned off by the DME 
Administrator, there will be less menu items than shown below. 
 

Create 
 E-mail 

Create a new e-mail. 
 Meeting 

Create a new meeting invitation or appointment. 
 

Synchronize 
 E-mail 

Synchronize e-mails only. 
 Calendar 

Synchronize calendar items only. 
 Contacts 

Synchronize contacts only. 
 To-do 

Synchronize to-dos (tasks) only. 
 Files 

Synchronize files only, if enabled. 
 All 

Synchronize all resources. 
 Cancel sync. 

Cancel an ongoing synchronization. Any changes made will be rolled back. 
 

Actions 
 Mark read 

Mark e-mails as read (Selected or All). 
 Mark unread 

Mark e-mails as unread (Selected or All). 
 Delete 

Delete selected e-mail (Delete or Backspace on virtual keyboard). 
 Delete all attachments 

Delete all attachments downloaded to the device. 
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 Sort 
Sort current folder by date, name or subject (ascending or descending). 

 Move to folder... 
Move the selected e-mail to an e-mail folder. 

 

Search 
 Global Address Book 

Search for e-mail address on the server. 
 E-mails (on server) 

Search for e-mails in your server mailbox. 
 E-mails (on phone) 

Search for e-mails stored locally. 
 

Tools 
 Settings 

Set up different aspects of DME on your device: General, Security, E-mail, Folders, 
Calendar, Contacts, To-do, Files, Scheduled sync.. 

 Import 
Import (wipe and load) items from the collaboration system to your device: E-mail, 
Calendar, Contacts, To-do, Files. 

 Change password 
Change your password to match that on the server. 

 Log 
Show the client's event log, and optionally send it as an e-mail. 

 

View 
 View 

Go to the Folders view, where you can choose which mailbox folder you want to 
work in, go to the internal DME Calendar, or open the Contacts or To-do (Tasks) 
application. 

 

About DME 
 About DME 

Display version information, OS information, and licence text. 
 





  If you need further assistance  

If you need further assistance 
If you have read this guide and still have questions concerning the function and use of 
the DME client, please contact your DME administrator (usually the internal IT 
department). 

Before contacting your DME administrator, be sure to have information about your 
DME version etc. ready.  

 Showing the current version of your DME client 
1 Open the DME menu (iPhone: tap Tools). 

2 Select About DME. 

 

 
DME keeps a log of the events that take place in the client. 

 Showing the DME client event log 
1 Open the DME menu (iPhone: tap Tools > Log). 

2 Select Tools. 

3 Select Log. 

 

 
If you are using the DME client for Windows Mobile, Java, or iPhone, you can tap 
Send log (iPhone: tap ) to insert the log text into a new mail, which you can then 
send to your Helpdesk. 

Please note that the DME administrator can request the client log using a feature in the 
DME Server (not iPhone). 
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If you are the DME administrator, you can contact your DME partner. 

You can also check the DME Support http://www.excitor.com website for more 
information. 

If you find errors or omissions in this documentation, please contact Documentation 
feedback see Documentation feedback - 
mailto:documentation@excitor.com?Subject=Documentation feedback. 
 

http://www.excitor.com/
mailto:documentation@excitor.com?Subject=Documentation%20feedback
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